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INTRODUCTION  

This guide is for individuals configuring a database for WinSPC and 

installing and configuring WinSPC on client stations. It consists of 

procedures to accomplish these tasks for the following database 

servers: 

Á Microsoft SQL Server 2005 

Á Microsoft SQL Server 2005 Express 

Á Microsoft SQL Server 2008 

Á Microsoft SQL Server 2008 Express 

Á Oracle 10g 

Á Oracle 11g 

The four Microsoft SQL Server editions are all dealt with in Chapter 

1: Microsoft SQL Server 2005/2008. A free download of Microsoft 

SQL Server 2005 Express as well as Microsoft SQL Server 2008 

Express are available at: www.winspc.com/downloads. (To access this 

web page, enter the username and password included in the e-mail 

notifying you of the release of WinSPC Version 8.0. If you did not 

receive an e-mail notification, contact the DataNet Quality Systems 

Product Support Help Desk at 248-447-0140.) 

WinSPC is certified to run in a traditional client/server environment 

and a Microsoft Terminal Services environment. The content in this 

guide applies to both except where marked by a Terminal Services 

marker, in which case the content applies uniquely to a Microsoft 

Terminal Services environment. The first appearance of the Terminal 

Services marker is to the right of the following paragraph. 

When an implementation involves a Microsoft Terminal Services 

environment, WinSPC must be installed on the Microsoft Terminal 

Services server. If the implementation does not also involve a 

client/server environment, make the Microsoft Terminal Services 

 

http://www.winspc.com/downloads
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server your first client. (First client simply refers to the first computer 

on which WinSPC is installed.) If the implementation also involves a 

client/server environment, it does not matter whether you make the 

Microsoft Terminal Services server the first client or an additional 

client. (Additional client means any computer on which WinSPC is 

installed other than the first client.) Electing to make the Microsoft 

Terminal Services server the first client means that the procedure for 

installing WinSPC on the Microsoft Terminal Services server is the 

procedure detailed in Phase 2 of the chapter specific to the database 

server being used in your implementation. Electing to make the 

Microsoft Terminal Services server an additional client means that the 

procedure for installing WinSPC on the Microsoft Terminal Services 

server is the procedure detailed in Chapter 5: Additional Client 

Installs and Configurations. 

For WinSPCôs hardware requirements and recommended platforms, 

see Appendix G: Hardware Requirements and Recommended 

Platforms. 

DataNet Quality Systems wants your installation and configuration to 

be a positive experience. Please do not hesitate to contact our Product 

Support Help Desk at (248)-447-0140 if you have questions 

concerning any of the information in this guide.
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CHAPTER 1: MICROSOFT SQL SERVER 2005/2008 

WinSPC is certified to run on the following editions of Microsoft SQL 

Server: Microsoft SQL Server 2005 Express, Microsoft SQL Server 2005, 

Microsoft SQL Server 2008 Express and Microsoft SQL Server 2008. This 

chapter applies to each of these editions. 

The procedure to configure any of these four editions for use with WinSPC is 

nearly identical to that of the other three. Consequently, where images of 

Microsoft SQL Server prompts are used for illustration, they are exclusively 

from Microsoft SQL Server 2005 Express. In addition, where the text of this 

chapter applies to all four editions equally, edition-specific information is 

omitted in favor of generic titles such as Microsoft SQL Server or SQL Server 

Management Studio. 

ASSUMPTIONS 

The instructions in this chapter are based on the following 

assumptions: 

Á Microsoft SQL Server is installed on your database server 

machine. 

Á An instance of Microsoft SQL Server has been created for 

WinSPC and is running. (This instance may be named or 

unnamed.) 

Á During the creation of this instance, the authentication mode 

selected was Mixed Mode (Windows Authentication and SQL 

Server Authentication). (WinSPC will not function if the default 

Windows Authentication Mode was accepted.) 
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Á The management and configuration tools appropriate to your 

edition of Microsoft SQL Server are installed on your database 

server machine. At a minimum, these include SQL Server 

Management Studio and SQL Server Configuration Manager. 

Á Other than the Mixed Mode of authentication and where an 

exception is clearly noted, the default values presented by your 

Microsoft SQL Server edition during the setup process were 

accepted without modification. 

Á Firewalls between your database server and the client stations to be 

used for WinSPC are configured to permit database traffic. 

Á For implementations employing a Microsoft Terminal Services 

environment, Microsoft Terminal Services is properly installed and 

configured on the server designated as your Microsoft Terminal 

Services server and the client stations that will run WinSPC on this 

server can successfully establish a Remote Desktop Protocol 

(RDP) connection to the server. 

Á The operating system of your database server machine is Windows 

Server 2003 or Windows Server 2008. 

Á The operating system of the client machines to be used for 

WinSPC is Windows 7, Windows Vista Business or Windows XP 

Pro. (Images of client machines included in this guide are from 

Vista Business.) 

NOTE: If a default value was modified during the setup Microsoft 

SQL Server or an operating system is different from that 

stated here, adapt the instructions in this guide as needed to 

accommodate the modified value or differing operating 

system. 
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SERVER CONFIGURATION  

Establish a Server Connection 

1. On the database server machine, launch SQL Server 

Management Studio, the default path for which is Start > All 

Programs > Microsoft SQL Server> SQL Server Management 

Studio. 

2. In the Connect to Server prompt that appears: 

a. At Server Type, accept the Database Engine default. 

b. At Server name, if a name is not displayed or the name 

displayed is not the name of the machine on which the instance 

of Microsoft SQL Server to be used for WinSPC is created, 

select the correct name from the dropdown list. Depending on 

your edition of Microsoft SQL Server and the options selected 

during this editionôs setup, the instance for your 

implementation may be named or unnamed. If your instance is 

named, the correct name for this Server name field consists of 

a combination of the server name and the instance name (e.g. 

TESTSERVER\SQLEXPRESS). If your instance is unnamed, 

the correct name for this Server name field consists of the 

server name alone (e.g. TESTSERVER). In the event the server 

name displayed is incorrect and the dropdown list does not 

contain the correct name: 

i. From the Server name dropdown list, select <Browse for 

moreé>. 

ii.  In the Browse for Servers prompt, click the Network 

Servers tab. This automatically initiates a search for 

servers on your network. 

Phase 1 of 4 
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iii.  When the search completes, expand Database Engine and 

single-click the desired server name or server 

name\instance name combination. 

iv. Click OK . 

c. At Authentication, select SQL Server Authentication. 

d. At Login, enter sa. 

e. At Password, enter the password assigned to the sa login. 

f. Click Connect. 
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NOTE: If the Connect to Server prompt is not displayed, click 

File > New > Database Engine Query in Microsoft 

SQL Server Management Studio and complete the 

preceding substeps in the Connect to Database Engine 

prompt. 
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Create a Database 

DataNet Quality Systems recommends that a new database be created 

for the exclusive use of WinSPC. Use of a WinSPC database by other 

applications is not tested and consequently not certified by DataNet. 

1. In the Object Explorer (i.e. the left pane) of Microsoft SQL 

Server Management Studio, right-click Databases and, from the 

shortcut menu, select New Database. 
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2. In the New Database prompt, at Database name, create and enter 

a name for the database. (The recommended database name is 

WinSPC.) 
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3. If you are configuring a full, as opposed to express, version of 

Microsoft SQL Server, you may want to consider changing the 

default Recovery Model from Full to Simple. This helps prevent 

Microsoft SQL Serverôs transaction log from growing to a point 

where it interferes with database performance. To change the 

Recovery Model to Simple, under Select a page, click Options 

and, at Recovery model select Simple. 
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NOTE:  According to Microsoft, with the Recovery Model set to 

Simple, a database can only be recovered to the time of 

the most recent backup. This means that data captured 

between the most recent backup and a failure which 

necessitates a recovery is lost. If this is an unacceptable 

risk for your organization, use the Full or Bulk -logged 

option and follow Microsoftôs recommendations to control 

the size of your transaction log. 

4. Click the New Database promptôs OK button. 
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Create a Server Login 

1. In the Object Explorer, right-click the Security folder and select 

New > Login. 

 

(The Security folder referred to here is the one in the root level of 

the folder for the server or server\instance you are configuring, not 

a Security sub-folder within a database folder under the root 

Databases folder.) 
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2. In the Login - New prompt: 

a. At Login name, create and enter a name for the login. (The 

recommended name is JOHNDOE.) 

b. Select SQL Server authentication. 

c. At Password, create and enter a sufficiently strong password 

for the login. 

d. At Confirm password, reenter the password. 

NOTE: The user name and password entered here will be used by 

Microsoft SQL Server to authentic WinSPC client 

stations and allow authenticated stations access to the 

WinSPC database. This user name and password 

combination is not directly used by WinSPC users.  

WinSPC users will, later, be assigned individual user IDs 

and passwords and will use these individual IDs and 

passwords to log into the WinSPC application on 

WinSPC client stations. 

e. Uncheck the Enforce password policy check box. 
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f. At Default database, select WinSPC.  
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3. Under Select a page (top left pane), single-click User Mapping 

and then, in the right portion of the prompt: 

a. Under Users mapped to this login, in the Map column, check 

the check box for the newly created WinSPC database. 

b. Under Database role membership for:  <Database Name>, 

check the db_owner check box. 

c. Click OK. 
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Configure the SQL Server Browser Service and Enable a Network 

Protocol 

1. Without exiting Microsoft SQL Server Management Studio, 

launch SQL Server Configuration Manager, the default path for 

which is Start > All Programs > Microsoft SQL Server > 

Configuration Tools > SQL Server Configuration Manager. 

2. If the Microsoft SQL Server instance you are working with is not a 

named instance, go to step 3. If the instance you are working with 

is a named instance, configure the SQL Server Browser service. 

(If you donôt know whether the instance is named or unnamed, 

assume it is named.) To configure the SQL Server Browser 

service: 

a. In the left pane of SQL Server Configuration Manager, click 

SQL Server Services. 
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b. In the right pane, right-click SQL Server Browser and select 

Properties. 

c. In the SQL Server Browser Properties prompt, click the 

Service tab. 

d. On this tab, to the right of Start Mode, click Disabled and 

select Automatic. 
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e. Click the Apply button. 

f. Click the Log On tab and on this tab click the Start button. 

 

g. Allow the progress bar that appears to complete. 

h. Click OK .  
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3. Enable a network protocol. To do this: 

a. In the left pane of SQL Server Configuration Manager, 

expand SQL Server Network Configuration  and single-click 

Protocols for <SERVER OR INSTANCE NAME >. 
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b. In the right pane, right-click either TCP/IP or Named Pipes 

and click Enable. (WinSPC works with either of these options. 

If you are unsure of which option to choose, consult your 

network administrator.) 

 

c. In the warning indicating that changes will not take effect until 

the service is stopped and restarted, click OK . 

 

d. Close SQL Server Configuration Manager. 



Chapter 1: Microsoft SQL Server 2005/2008 

  Installation and Configuration Guide 21 

e. In Micr osoft SQL Server Management Studio, right-click 

the server youôve been configuring and select Stop. 

 

f. In the message box that appears, click Yes to confirm you want 

to stop the service. 
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g. When the message box closes, right-click the server again and 

select Start. 
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h. In the message box that appears, click Yes to confirm you want 

to start the service. 

 

i. Click File > Exit to close Microsoft SQL Server 

Management Studio. 

 

THIS COMPLETES PHASE 1 OF 4. 

GO TO THE NEXT PAGE AND COMPLETE PHASE 2. 
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Phase 2 of 4 

  
 

FIRST CLIENT INSTALL AND CONFIGURATION (INITIAL STEPS) 

This section concerns the installation and configuration of WinSPC on 

the first WinSPC client. The first WinSPC client refers to the first 

computer on which you want to install WinSPC. This computer can be 

any computer on your network.  

If your implementation employs Microsoft Terminal Services, see the 

discussion on page 1 of this guide for direction on whether to make 

your first client the Microsoft Terminal Services server or another 

computer.   

1. Create a folder on a network file server accessible by all client 

stations that will run WinSPC. This folderôs primary purpose is to 

facilitate the installation and configuration of WinSPC on all 

clients other than the first client. (The recommended name for this 

folder is WinSPCRemote.) 

2. Share this folder and grant domain administrators at least the 

minimum required permissions to it. For file servers running 

Windows Server 2003, the minimum Share permissions are 

Change and the minimum Security permissions are Modify .  For 

file servers running Windows Server 2008, the minimum Share 

permissions are Contributor  and the minimum Security 

permissions are Modify . (For a procedure on granting Share or 

Security permissions, see Appendix D: Granting Share and 

Security Permissions.) 

NOTE: If your WinSPC implementation is part of a workgroup 

rather than a domain, grant these minimum permissions 

to the local administrator who will install and configure 

WinSPC on the first WinSPC client. 
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3. Log into Windows on the first WinSPC client as a domain 

administrator who also has local administrator privileges. 

NOTE: If the first WinSPC client is part of a workgroup instead 

of a domain, log in as a local administrator. 

4. If the operating system of the first client is Windows 7 or Vista, 

disable User Account Control (UAC). Refer to Appendix H for 

instructions on doing this. 

5. If you downloaded Install.exe from winspc.com/downloads: 

a. Transfer this file to the first WinSPC client if it was 

downloaded to a different computer. 

b. Double-click the file. 

c. If an Open File ï Security Warning prompt appears, click 

Run. 

d. Go to step 7.  

http://www.winspc.com/downloads
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6. If you have the WinSPC CD (whether as a result of receiving it 

from DataNet Quality Systems or burning it from the WinSPC.iso 

file at winspc.com/downloads) and you did not complete the 

preceding step: 

a. Insert and run the CD. 

b. On the WinSPC Version 8.0 setup prompt that appears, click 

Install or Upgrade. 

 

c. Go to step 7. 

http://www.winspc.com/downloads


Chapter 1: Microsoft SQL Server 2005/2008 

  Installation and Configuration Guide 27 

7. Complete the WinSPC Installation Wizard. 

NOTE: The prompts of this wizard are intended to be self-

explanatory. Consequently, they are not detailed here. If 

you have a question about a prompt or want to be directed 

step-by-step through the wizard, see Appendix A: The 

WinSPC Installation Wizard . 

8. Complete Appendix B: Installing NJWin for an Asian 

Language if the first client will need to run WinSPC in an Asian 

language or you would like to run the WinSPC Configuration 

Wizard in an Asian language. (The WinSPC Configuration Wizard 

is the tool you will use next. As its name implies, it is the tool used 

to configure WinSPC.) 

9. If you installed WinSPC from a CD, exit the WinSPC Version 8.0 

setup prompt by clicking Close in the upper right corner and 

remove the CD from the CD-ROM drive. 

10. Click Start > All Programs > WinSPC > WinSPC.  This 

launches the WinSPC Configuration Wizard. 
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11. On the Language prompt, from the Select language list, choose a 

language and click Next. 

 

NOTE: The language selected here is the language in which the 

remainder of the WinSPC Configuration Wizard will run. 

It also becomes the system-wide default language for 

WinSPC. (This default language can be changed at any 

time following the completion of the WinSPC 

Configuration Wizard. Once the configuration of the first 

WinSPC client is complete, you can see the WinSPC 

Help for more information on default languages.) 
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12. On the Database Server Type prompt, select your Microsoft 

SQL Server edition and click Next. 
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13. On the Microsoft SQL Server Settings prompt: 

a. At Machine Name, if the instance of Microsoft SQL Server 

designated for WinSPC is a named instance, enter the name of 

the machine on which the instance is created and the name of 

the instance, separating the two by a backslash (e.g. 

Testserver\SQLExpress). If the instance is an unnamed 

instance, enter the server name only. If you do not know 

whether the instance is named or unnamed or if you know the 

instance is named but are unsure of the name used, contact the 

server administrator. 

b. At Database Name, enter the database name you chose in step 

2 of this chapterôs Create a Database section. 

c. Click Next. 
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14. On the Database Server Log In prompt, enter the server User 

Name and Password created in step 2 of this chapterôs Create a 

Server Login section and click Next. 
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15. On the Database Communications Test prompt, click Next. 

 

If you get a Database Communications Error indicating there is 

an invalid connection string attribute, the communication test 

failed. The most likely causes of the failure and their remedies are: 

Á The database server login was entered incorrectly. To remedy 

this, click the Back button two times and re-enter the user 

name and password, ensuring you have the correct user name 

and password and that these are spelled correctly. Also, since 

passwords are case sensitive, ensure appropriate capitalization 

is used for the password. Once you have re-entered the login, 

click Next and advance through the WinSPC Configuration 

Wizard again, verifying the information on each prompt as you 

do. 
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Á The machine name, instance name or database name was 

entered incorrectly. To remedy this, click the Back button 

three times and re-enter the machine name, instance name (if 

you are working with a named instance) and database name, 

ensuring you have the correct names and that these are spelled 

correctly. Also, when entering an instance name, ensure it is 

properly separated from the machine name by a backslash (e.g. 

Testserver\SQLExpress.) Once you have re-entered the 

name(s), click Next and advance through the WinSPC 

Configuration Wizard again, verifying the information on each 

prompt as you do. 

Á The instance being used for WinSPC is a named instance but 

the SQL Server Browser service is not configured. To remedy 

this, complete steps 1 and 2 of the Configure the SQL Server 

Browser Service and Enable a Network Protocol section 

earlier in this chapter, then click the Back button in the 

WinSPC Configuration Wizard once and try the database 

communications test again. 

Á A network protocol has not been enabled. To remedy this, 

repeat steps 1 and 3 of the Configure the SQL Server 

Browser Service and Enable a Network Protocol section 

earlier in this chapter, then click the Back button in the 

WinSPC Configuration Wizard once and try the database 

communications test again. 
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Á A network protocol was enabled but the instance was not 

restarted afterwards. To remedy this, repeat steps 1 and 3e-3h 

of the Configure the SQL Server Browser Service and 

Enable a Network Protocol section earlier in this chapter, 

then click the Back button in the WinSPC Configuration 

Wizard once and try the database communications test again. 

16. On the Database Creation prompt, click Next.  This creates the 

WinSPC schema within the WinSPC database. 
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17. Allow the promptôs progress bar to complete. 
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18. If you selected a language other than English in step 11 of this 

section, an Add Language prompt appears once the WinSPC 

schema is created. In this case: 

a. Insert the language disk for the selected language into your 

floppy drive and click the OK  button. (Language disks are 

included in your WinSPC materials. If you didnôt order a 

language disk and, consequently, did not receive one, click the 

Cancel button and complete the WinSPC Configuration 

Wizard without adding the language. Later, you can order the 

language disk and, once the disk arrives, add the language 

using the Add Language option on the Administrator 

windowôs Tools menu in WinSPC. Until the language is added, 

youôll be restricted to running WinSPC in English. The 

remainder of the WinSPC Configuration Wizard continues to 

run in the selected language whether or not a language is added 

from a language disk.)  

b. In the message asking if you want to proceed with the addition 

of the detected language, click OK . 

c. If a message indicating the detected language has already been 

installed appears, click OK . 

d. Allow the Adding New Language progress bar to complete. 

e. When the You may now select the desired language in the 

System Settings, Station Setup, or User Setup message 

appears, click OK .   

f. If the Add Language prompt reappears, click Cancel. 

g. Remove the language disk from the floppy drive. 
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THIS COMPLETES PHASE 2 OF 4.   

GO TO CHAPTER 4: FIRST CLIENT 

CONFIGURATION  (FINAL STEPS) AND 

COMPLETE PHASE 3. 
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CHAPTER 2: ORACLE 10g 

ASSUMPTIONS 

The instructions in this chapter are based on the following 

assumptions: 

Á Oracle Database 10g software is installed on your database server. 

Á An Oracle Database 10g global database of the Enterprise 

Edition installation type is created and running on your database 

server and you have been authorized to use part of this global 

database for WinSPC. 

Á Oracle Database 10g Client is installed on the first WinSPC client 

and that installation is of the Administrator  type (as compared to 

the Runtime or Custom types). (The first WinSPC client refers to 

the first computer on which you want to install WinSPC. This 

computer can be any computer on your network. If the operating 

system of this client is Windows Vista Business, you must use the 

10.2.0.3.0 edition of Oracle Database 10g Client. If the operating 

system is Windows XP Pro, you may use either the 10.2.0.3.0 

edition or the earlier 10.2.0.1.0 edition.) 

Á The necessary Oracle Database 10g Client utilities are installed an 

all other clients. (If the operating system of an additional client is 

Windows Vista Business, the necessary utilities are Oracle 

Provider for OLE DB and Oracle Net from the 10.2.0.3.0 edition 

of Oracle Database 10g Client. If the operating system is Windows 

XP Pro, the necessary utilities vary with the edition of Oracle 

Database 10g Client being used. If that edition is 10.2.0.3.0, the 

necessary utilities are the same as those for Windows Vista 

Business. If that edition is 10.2.0.1.0, the necessary utilities consist 

only of Oracle Provider for OLE DB.  Incidentally, regardless of 

the operating system or edition of Oracle Database 10g Client 
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installed on your clients, if your organizationôs intended use of 

WinSPC includes taking data stored in an Oracle ODBC data 

source and collecting it into the Oracle database you are 

configuring for WinSPC, Oracle ODBC Driver from Oracle 

Database 10g Client will need to be installed on each WinSPC 

client to be used in collecting that stored data. Since the presence 

of this driver presents no complication, DataNet Quality Systems 

recommends installing it even if the use of WinSPC to collect data 

from an Oracle ODBC data source is only a possibility. The 

Administrator type of client mentioned in the preceding 

assumption includes this driver and consequently does not need to 

separately installed on the first WinSPC client.) 

Á The default values presented by Oracle Database 10g and Oracle 

Database 10g Client during the installation process were accepted 

without modification. 

Á Any firewalls between your database server and the client stations 

to be used for WinSPC are properly configured to permit database 

traffic. 

Á For implementations employing a Microsoft Terminal Services 

environment, Microsoft Terminal Services is properly installed and 

configured on the server designated as your Microsoft Terminal 

Services server. 

NOTE: You may find that users who donôt have administrative 

permissions to the Microsoft Terminal Services server are 

unable to launch WinSPC via a Remote Desktop Protocol 

session. This is a circumstance specific to Oracle 

Database 10g and Oracle Database 11g. It can be 

remedied by changing the Permission Capability  on the 

Microsoft Terminal Services server from Full Security to 
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Relaxed Security. Alternatively, consult your network 

administrator and/or Oracle DBA for other remedies.   

Á The operating system of your database server machine is Windows 

Server 2003 or Windows Server 2008. 

Á The operating system of the client machines to be used for 

WinSPC is Windows 7, Windows Vista Business or Windows XP 

Pro. (Images of client machines included in this guide are from 

Vista Business.) 

NOTE: If a default value was modified during the installation of 

Oracle Database 10g or an operating system is different from 

that stated here, adapt the instructions in this guide as needed 

to accommodate the modified value or differing operating 

system. 

Prior to beginning this procedure, itôs advised that you locate 

the hostname (or machine name) for the Oracle Database 10g 

machine and the Oracle Database 10g global database system 

identifier (SID), user name and password. Your database 

administrator should be able to provide this information. 
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Phase 1 of 4 

  
 

  
  

 

SERVER CONFIGURATION  

Create a Tablespace 

1. On the first WinSPC client station, launch the Enterprise 

Manager Console. The default path for this is: Start > All 

Programs > Oracle ï OraClient10g_home1 > Enterprise 

Manager Console. (See the third assumption at the beginning of 

this chapter for a definition of the first WinSPC client.) 

NOTE: If the Enterprise Manager Console is not listed in the 

Start menu, it is probably because the Administrator  

installation type was not selected when Oracle Database 

10g Client was installed. In this case, reinstall Oracle 

Database 10g Client, selecting Administrator  in the 

Select Installation Type prompt and then return to this 

step. 

2. In the Add Databases To Tree prompt: 

a. At Hostname, enter the machine name of the Oracle Database 

10g server. 

b. At Port Number, accept the default value of 1521 unless your 

DBA has instructed you to use a different port number. 

c. At SID, enter the system identifier for the Oracle global 

database to be used by WinSPC. 

d. At Net Service Name, overwrite the net service name that is 

automatically created with a name you want to use to uniquely 

identify the WinSPC net service. (The recommended net 

service name is WINSPC.)   
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e. Click OK. 

 

NOTE: If the Add Databases To Tree prompt doesnôt 

automatically appear after step 1, it can be displayed by 

selecting Add Database To Tree from the Navigator 

menu in the Oracle Enterprise Manager Console. 
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3.   In the left pane of the Oracle Enterprise Manager Console, 

expand Network > Databases and click the plus sign to the left of 

the net service name from step 2d. 
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4.   In the Database Connect Information prompt that is displayed:  

a. At Username, enter the username for the global database. 

b. At Password, enter the password associated with this user 

name. 

c. At Connect as, select SYSDBA from the dropdown list. 

d. Click OK. 
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5.   In the left pane, beneath the newly added net service name, expand 

Storage, right-click Tablespaces and, from the shortcut menu, 

select Create. 

NOTE: If you do not see Create on the shortcut menu, press the 

ESC button to exit the menu and right-click Tablespaces 

again. 

 



Chapter 2: Oracle 10g 

  Installation and Configuration Guide 47 

6.   In the Create Tablespace prompt, on the General tab: 

a. At Name, create and enter a name for the tablespace to be used 

for WinSPC. (Notice that, as you enter the name, it is 

automatically populated into the Datafiles section, forming a 

file name for the tablespace.) 
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b. At Size, double-click 5. 
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7.   In the Create Datafile prompt that is displayed, click the Storage 

tab. 

 



Chapter 2: Oracle 10g 

50 Installation and Configuration Guide 

8.   On the Storage tab: 

a. Check the Automatically extend datafile when full 

(AUTOEXTEND)  check box. 

b. Specify 5 M Bytes as the size by which the datafile should be 

incremented. (Your database administrator can monitor your 

database usage and tune this value as needed.) 

c. At Maximum Size, accept the default Unlimited . 
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d. Click OK. 
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9.   In the Create Tablespace prompt, click Create. 
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10.  When the Tablespace created successfully message appears, 

click OK . 

 

Create a Server Login 

1. Still beneath the newly created net service name, expand Security, 

right-click Users and, from the shortcut menu, click Create. 



Chapter 2: Oracle 10g 

54 Installation and Configuration Guide 

 

2. In the Create User prompt, on the General tab: 

a. At Name, create and enter a name for the login. (The 

recommended user name is JOHNDOE.) 
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b. At Enter Password, create and enter a sufficiently strong 

password for the login. 

c. At Confirm Password, reenter the password. 

NOTE: The name and password entered here will be used by 

Oracle Database 10g to authentic WinSPC client stations 

and allow authenticated stations access to the WinSPC 

tablespace. This name and password combination is not 

directly used by WinSPC users. WinSPC users wil l, later, 

be assigned individual user IDs and passwords. They will 

use these individual user IDs and passwords to log into 

the WinSPC application on WinSPC client machines. 

d. In the Tablespaces section, at Default, select the tablespace 

name created in step 6a of this chapterôs Create a Tablespace 

section.  

e. At Temporary, select TEMP .  
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f. Leave Status as Unlocked. 
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3. Without clicking Create, click the Role tab and, in the Available 

list, double-click RESOURCE. This copies RESOURCE to the 

Granted list. 
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4. Click the System tab and, in the Available list, double-click 

CREATE ANY INDEX . This copies CREATE ANY INDEX  to 

the Granted list. 
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5. Click Create. 

6. When the User created successfully message appears, click OK . 

 

Set the Number of Open Cursors 

1. Calculate the required number of open cursors using this formula: 

open_cursors = number of WinSPC licenses * 50 
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2. Still in the Oracle Enterprise Manager Console, in the left pane, 

expand Instance and click Configuration .  
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3. In the right pane, click All Initialization Parameters  toward the 

bottom of the General tab. 

 

4. In the Edit Database: Configuration prompt, scroll to 

open_cursors, replace the default number of open cursors in the 

Value column with the number you calculated in step 1 and click 

Apply . 
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5. When the Parameters have been changed message appears, click 

OK .  

 

6. Close the Oracle Enterprise Manager Console by clicking File > 

Exit . 

Test the Local Net Service Name 

1. Still on the first client machine, click Start > All Programs > 

Oracle ï OraClient10g_home1 > Configuration and Migration 

Tools > Net Configuration Assistant. 
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2. In the Oracle Net Configuration Assistant: Welcome prompt, 

select Local Net Service Name configuration and click Next. 
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3. Select Test and click Next. 
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4. Select the net service name you specified in step 2d of this 

chapterôs Create a Tablespace section, if it isnôt already selected, 

and click Next.  
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5. In the next prompt, which indicates the test did not succeed, click 

the Change Login button. 
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6. In the Change Login prompt, replace the default username and 

password with the username and password you created in step 2 of 

this chapterôs Create a Server Login section and click OK . 
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7. When the test is indicated as having succeeded, click Next. 
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8. Click Next when the net service name configuration is indicated as 

complete. 
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9. On the Welcome prompt, click Finish. 

 

 

THIS COMPLETES PHASE 1 OF 4. 

GO TO THE NEXT PAGE AND COMPLETE PHASE 2. 
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Phase 2 of 4 

  
 

FIRST CLIENT INSTALL AND CONFIGURATION (INITIAL STEPS) 

This section concerns the installation and configuration of WinSPC on 

the first WinSPC client. (See the third assumption at the beginning of 

this chapter for a definition of the first WinSPC client.) 

If your implementation employs Microsoft Terminal Services, see the 

discussion on page 1 of this guide for direction on whether to make 

your first client the Microsoft Terminal Services server or another 

computer.   

1. Create a folder on a network file server accessible by all client 

stations that will run WinSPC. This folderôs primary purpose is to 

facilitate the installation and configuration of WinSPC on all 

clients other than the first client. (The recommended name for this 

folder is WinSPCRemote.) 

2. Share this folder and grant domain administrators at least the 

minimum required permissions to it. For file servers running 

Windows Server 2003, the minimum Share permissions are 

Change and the minimum Security permissions are Modify .  For 

file servers running Windows Server 2008, the minimum Share 

permissions are Contributor  and the minimum Security 

permissions are Modify . (For a procedure on granting Share or 

Security permissions, see Appendix D: Granting Share and 

Security Permissions.) 

NOTE: If your WinSPC implementation is part of a workgroup 

rather than a domain, grant these minimum permissions 

to the local administrator who will install and configure 

WinSPC on the first WinSPC client station. 

 



Chapter 2: Oracle 10g 

  Installation and Configuration Guide 75 

3. Log into Windows on the first WinSPC client station as a domain 

administrator who also has local administrator privileges. 

NOTE: If the first WinSPC client is part of a workgroup instead 

of a domain, log in as a local administrator. 

4. If the operating system of the first client is Windows 7 or Vista, 

disable User Account Control (UAC). Refer to Appendix H for 

instructions on doing this. 

5. If you downloaded Install.exe from winspc.com/downloads: 

a. Transfer this file to the first WinSPC client if it was 

downloaded to a different computer. 

b. Double-click the file. 

c. If an Open File ï Security Warning prompt appears, click 

Run. 

d. Go to step 7.  

http://www.winspc.com/downloads
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6. If you have the WinSPC CD (whether as a result of receiving it 

from DataNet Quality Systems or burning it from the WinSPC.iso 

file at winspc.com/downloads) and you did not complete the 

preceding step: 

a. Insert and run the CD. 

b. On the WinSPC Version 8.0 setup prompt that appears, click 

Install or Upgrade. 

 

c. Go to step 7. 

 

http://www.winspc.com/downloads
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7. Complete the WinSPC Installation Wizard. 

NOTE: The prompts of this wizard are intended to be self-

explanatory. Consequently, they are not detailed here. If 

you have a question about a prompt or want to be directed 

step-by-step through the wizard, see Appendix A: The 

WinSPC Installation Wizard . 

8. Complete Appendix B: Installing NJWin for an Asian 

Language if the first client station will need to run WinSPC in an 

Asian language or you would like to run the WinSPC 

Configuration Wizard in an Asian language. (The WinSPC 

Configuration Wizard is the tool you will use next in this first 

client configuration process.) 

9. If you installed WinSPC from a CD, exit the WinSPC Version 8.0 

setup prompt by clicking Close in the upper right corner and 

remove the WinSPC CD from the CD-ROM drive. 

10. Click Start > All Programs > WinSPC > WinSPC.  This 

launches the WinSPC Configuration Wizard. 
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11. On the Language prompt, from the Select language list, choose a 

language and click Next.  

 

NOTE: The language selected here is the language in which the 

remainder of the WinSPC Configuration Wizard will run. 

It also becomes the system-wide default language for 

WinSPC. (This default language can be changed at any 

time following the completion of the WinSPC 

Configuration Wizard. Once the configuration of the first 

WinSPC client is complete, you can see the WinSPC 

Help for more information on default languages.) 
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12. On the Database Server Type prompt, select Oracle Database 

10g and click Next. 
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13. On the Oracle Server Settings prompt: 

a. At Path of TNSNAMES.ORA, accept the default location. 

b. In the Database Alias text box, enter the Net Service Name 

you chose in step 2d of this chapterôs Create a Tablespace 

section. 

c. Click Next. 
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14. On the Database Server Log In prompt, enter the server User 

Name and Password created in step 2 of this chapterôs Create a 

Server Login section and click Next. 
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15. On the Database Communications Test prompt, click Next. 

 

In the event the test fails: 

Á If the error message displayed reads ORA-12154: TNS: could 

not resolve the connect identifier specified., click the Back 

button three times and reenter the database alias, ensuring you 

have the correct name and that it is spelled correctly. Once 

youôve reentered this information, advance through the 

WinSPC Configuration Wizard again by clicking Next, 

verifying the information on each prompt as you do. 
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Á If the error message reads ORA-01017: invalid 

username/password; logon denied, click the Back button 

twice and reenter the server user name and password, ensuring 

you have the correct user name and password and that these are 

spelled correctly. Also, since passwords are case sensitive, 

ensure the appropriate capitalization is used for the password. 

Once youôve reentered this information, advance through the 

WinSPC Configuration Wizard again by clicking Next, 

verifying the information on each prompt as you do. 

16. On the Database Creation prompt, click Next.  This creates the 

WinSPC schema within the WinSPC database. 
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17. Allow the promptôs progress bar to complete. 
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18. If  you selected a language other than English in step 11 of this 

section, an Add Language prompt appears once the WinSPC 

schema is created. In this case: 

a. Insert the language disk for the selected language into your 

floppy drive and click the OK  button. (Language disks are 

included in your WinSPC materials. If you didnôt order a 

language disk and, consequently, did not receive one, click the 

Cancel button and complete the WinSPC Configuration 

Wizard without adding the language. Later, you can order the 

language disk and, once the disk arrives, add the language 

using the Add Language option on the Administrator 

windowôs Tools menu in WinSPC. Until the language is added, 

youôll be restricted to running WinSPC in English. The 

remainder of the WinSPC Configuration Wizard continues to 

run in the selected language whether or not a language is added 

from a language disk.)  

b. In the message asking if you want to proceed with the addition 

of the detected language, click OK . 

c. If a message indicating the detected language has already been 

installed appears, click OK . 

d. Allow the Adding New Language progress bar to complete. 

e. When the You may now select the desired language in the 

System Settings, Station Setup, or User Setup message 

appears, click OK . 

f. If the Add Language prompt reappears, click Cancel. 

g. Remove the language disk from the floppy drive. 
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THIS COMPLETES PHASE 2 OF 4. 

GO TO CHAPTER 4: FIRST CLIENT 

CONFIGURATIO N (FINAL STEPS) AND 

COMPLETE PHASE 3. 
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CHAPTER 3: ORACLE 11g 

ASSUMPTIONS 

The instructions in this chapter are based on the following 

assumptions: 

Á Oracle Database 11g software is installed on your database server 

and the installation type is Enterprise Edition . 

Á Oracle Database 11gôs Starter database is created and running on 

your database server and you have been authorized to use this 

database for WinSPC. 

Á The Net Configuration Assistant from Oracle Database 11g 

Client is installed on the first WinSPC client machine. (The first 

WinSPC client machine simply refers to the first computer on 

which you want to install WinSPC.  This computer can be any 

client machine on your network.) 

Á Oracle Provider for OLE DB  from Oracle Database 11g Client is 

installed on all client machines which are to run WinSPC 

(including the first client). (Incidentally, if your organizationôs 

intended use of WinSPC includes taking data stored in an Oracle 

ODBC data source and collecting it into the Oracle database you 

are configuring, Oracle ODBC Driver from Oracle Database 11g 

Client will need to be installed on each WinSPC client to be used 

in collecting that stored data. Since the presence of this driver 

presents no complication, DataNet Quality Systems recommends 

installing it even if the use of WinSPC to collect data from an 

Oracle ODBC data source is only a possibility.) 

Á The default values presented by Oracle Database 11g during the 

installation process were accepted without modification.   
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Á Any firewalls between your database server and the client 

machines to be used for WinSPC are properly configured to permit 

database traffic. 

Á For implementations employing a Microsoft Terminal Services 

environment, Microsoft Terminal Services is properly installed and 

configured on the server designated as your Microsoft Terminal 

Services server. 

NOTE: You may find that users who donôt have administrative 

permissions to the Microsoft Terminal Services server are 

unable to launch WinSPC via a Remote Desktop Protocol 

session. This is a circumstance specific to Oracle 

Database 10g and Oracle Database 11g. It can be 

remedied by changing the Permission Capability on the 

Microsoft Terminal Services server from Full Security to 

Relaxed Security. Alternatively, consult your network 

administrator and/or Oracle DBA for other remedies.   

Á If the edition of Oracle Database 11g to be configured for use 

with WinSPC is Release 2, the Server Class option was selected 

during the installation. This option is presented on the on the 

System Class installation prompt but is not selected by default.   

Á The operating system of your database server machine is Windows 

Server 2003 or Windows Server 2008. 

Á The operating system of the client machines to be used for 

WinSPC is Windows 7, Windows Vista Business or Windows XP 

Pro. (Images of client machines included in this guide are from 

Vista Business.) 
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NOTE: If a default value was modified during the installation of 

Oracle Database 11g or an operating system is different from 

that stated here, adapt the instructions in this guide as needed 

to accommodate the modified value or differing operating 

system. Prior to beginning this procedure, itôs advised that 

you locate the hostname (or machine name) for the Oracle 

Database 11g machine and the global database name and 

SYS account password assigned during the installation of 

Oracle Database 11g. Your database administrator should be 

able to provide this information. 
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Phase 1 of 4 

  
 

  
  

 

SERVER CONFIGURATION  

Create a Tablespace 

1. On the database server machine, launch Database Control for the 

database to be used by WinSPC. The default path for this is Start 

> All Programs > Oracle ï OraDB11g_home1 > Database 

Control  - orcl. 

2. On the Oracle Enterprise Manager 11g login page that is 

displayed: 

a. At User Name, enter SYS. 

b. At Password, enter the password for the SYS user name. 

c. At Connect As, select SYSDBA. 

d. Click Login. 
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3. On the Oracle Enterprise Manager 11g page that appears, click 

Server. 

 

4. On the Server page, under Storage, click Tablespaces. 
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5. On the Tablespaces page, click Create. 

 

6. On the Create Tablespace page, at Name, enter a name for the 

tablespace to be used by WinSPC and then, in the bottom right 

corner, click Add. 
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7. On the Add Datafile page: 

a. At File Name, enter a name for the datafile to be used by 

WinSPC. 

b. At File Size, enter 5 MB. 

c. At Storage, check the Automatically extend datafile when 

full (AUTOEXTEND) check box and specify an Increment 

amount of 5 MB. 

d. Click Continue. 
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8. On the Create Tablespace page, note the Information message 

that is displayed and click OK . 

 

9. On the Tablespaces page, note the Confirmat ion message that 

appears and, directly above it, click Database Instance. 
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Create a Server Login 

1. Back on the Server page, under Security, click Users. 

 

2. On the Users page, click Create. 
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3. On the Create User page: 

a. At Name, create and enter a name for the login.  (The 

recommended user name is JOHNDOE.) 

b. At Enter Password, create and enter a sufficiently strong 

password for the login. 

c. At Confirm Password, reenter the password. 

NOTE: The name and password entered here will be used by 

Oracle Database 11g to authentic WinSPC client 

machines and allow authenticated machines access to the 

WinSPC tablespace. This name and password 

combination is not directly used by WinSPC users.  

WinSPC users wil l, later, be assigned individual user IDs 

and passwords. They will use these individual user IDs 

and passwords to log into the WinSPC application on 

WinSPC client machines. 

d. At Default Tablespace, enter the tablespace name specified in 

step 6 of this chapterôs Create a Tablespace section. 

e. At Temporary Tablespace, enter TEMP .  
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f. Without clicking OK , click the Roles tab. 

 

4. On the Roles tab, click Edit List . 

 



Chapter 3: Oracle 11g 

98 Installation and Configuration Guide 

5. On the Modify Roles page, from the Available Roles list, select 

RESOURCE and click Move. 

 

This moves RESOURCE to the Selected Roles list. 

6. Click OK . 

7. Back on the Create User page, click System Privileges. 

 

8. On the System Privileges tab, click Edit List . 
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9. On the Modify System Privileges page, from the Available 

System Privileges list, select CREATE ANY INDEX  and click 

Move. 

 

This moves CREATE ANY INDEX  to the Selected System 

Privileges list. 

10. Click OK . 

11. Back on the Create User page, click OK again. 
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12. On the Users page, note the Confirmation message that appears 

and, directly above it, click Database Instance. 

 

Set the Number of Open Cursors 

1. Calculate the required number of open cursors using this formula: 

open_cursors = number of WinSPC licenses * 50 

2. On the Server page again, under Database Configuration , click 

Initialization Parameters.  
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This causes the Initialization Parameters page to appear. 

 

3. On this page, scroll down until, in the Name column, you see 

open_cursors and, in this rowôs Value column, enter the number 

you calculated in step 1 of this section. 
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4. Scroll back up to the top of the page and click Apply , noting the 

Update Message that appears as a result. 

 

5. Click Logout in the top right corner of the Oracle Enterprise 

Manager 11g page. 

6. Close your browser. 

Add the Local Net Service Name 

1. On the first client machine, launch Net Configuration Assistant, 

the default path for which is Start > All Programs > Oracle ï 

OraClient11g_home1 > Configuration and Migration Tools  > 

Net Configuration Assistant. 
































































































































































































